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About This Manual

You can use this manual to familiarize yourself with DIAdem functions and how to use them. 
Each chapter describes a DIAdem panel.

This manual contains exercises for finding, analyzing, and presenting data, and for automating 
each step of the process. These short exercises make it easier for you to get started with DIAdem. 
At the end of each chapter there is a summary of the most important contents. 

Related Documentation
For more information on DIAdem, refer to the following documentation:

• DIAdem Help

You can open the DIAdem Help in every dialog box with the Help button, or in the menu 
Help»Content, or with <F1>. The DIAdem Help offers procedures and dialog box help for 
each panel, and references for programmers. 

The introduction to the DIAdem help explains the structure of DIAdem and how to use 
DIAdem to find data, to run analyses, to create reports, and to combine all functions in a 
script. 

• SystemLink TDM Help

With SystemLink TDM, you handle data and evaluations centrally on a server. 
SystemLink TDM has applications for data indexing, data preparation, and analysis 
automation. The client user uses Data Navigation to navigate and search in indexed data 
and Data Analysis to check shared automation tasks. 

With DIAdem as your developing environment, you can create and test analysis scripts and 
automated report generation. 
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1
Introduction to DIAdem

DIAdem is the interactive National Instruments software for finding and managing technical 
data, for mathematically and graphically-interactively analyzing data, and for presenting data in 
reports. In a standardized environment, DIAdem offers a unique combination of tools that are 
tailored to the requirements of technicians, engineers, and scientists. You can adjust all the tools 
to your tasks and automate them in scripts, which reduce evaluation time substantially. 

The DataFinder enables you to find test data quickly and easily, and to identify corresponding 
data. Using DataFinder does not require a database or IT support, but is ready to use immediately 
after installing DIAdem.

Working with DIAdem
DIAdem groups related functions in panels. Use the panel bar that is on the left of the DIAdem 
screen to switch panels. Each panel provides all the tools for one of the following tasks:

• Use DIAdem NAVIGATOR to find, to load, and to manage data. Use the DataFinder to 
search for data on your computer and in the network, and to navigate through the found data 
files and databases. You load the data into the Data Portal so that all DIAdem panels can 
work with the data, which is organized in channels.

• Use DIAdem VIEW to view, to analyze, and to edit data as curves in axis systems. In 
channel tables you can edit and delete the data as values and enter new data. You 
synchronize videos or the map display of a test drive with data. They represent 3D data in 
two-dimensional contour areas.

• Use DIAdem ANALYSIS to analyze data mathematically. You can apply predefined 
standard mathematical functions, including basic mathematics, curve fitting, signal 
analysis, and statistics. The dialog boxes for these standard functions guide you through the 
calculation, so you do not have to enter a formula. You select the input data and the settings. 
Use the DIAdem Calculator to define and calculate your own formulas.

• Use DIAdem REPORT to document data and present results. In 2D and 3D axis systems, 
you display your data as curves, bar diagrams, and surfaces. In 2D and 3D tables, you list 
channel contents. You can label your report with comments and text and illustrate the report 
with graphics and formulas.

• Use DIAdem SCRIPT to automate tasks in a script, which combines several work steps for 
recurring sequences such as standard calculations and serial evaluations. Scripts, which you 
can record interactively, use the functions of all DIAdem panels. You can add program 
structures and dialog boxes to scripts in the integrated script editor. 
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• With DIAdem DAC and DIAdem VISUAL you acquire data, control processes, and 
visualize data. In DIAdem DAC you create block diagrams to acquire measured values, and 
to process and to output the data online. In DIAdem VISUAL you design the visualization 
screen, display the acquired and calculated measurement values, and influence the 
measurement with input instruments.

When you select a panel, the user interface changes so that you can quickly access the functions 
you want. Each DIAdem panel has, as shown in Figure 1-1, its own group bar to the right of the 
panel bar. Open a group bar, click a function group, and select a function. The workspace also 
changes with the DIAdem panel and displays a folder hierarchy or a worksheet. The toolbars and 
the context menus contain frequently used functions, which DIAdem also adapts to the selected 
panel.

Figure 1-1.  The Elements of the DIAdem User Interface

1 Panel bar
2 Group bar
3 Function group
4 Tooltip of the selected function

5 DIAdem VIEW toolbar
6 Data Portal
7 DIAdem VIEW workspace
8 Properties in the Data Portal

1

2

3

4

5

6

7

8
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Introduction Screen
When you launch DIAdem, the DIAdem introduction screen appears. 

Visit NI's DIAdem channel on YouTube to learn how to use DIAdem. Short videos show how to 
present data in a report, how to synchronize measurement data with a video of the experiment, 
or how to automate the many steps of an interactive evaluation.

Open the Examples Gallery to load and run examples in DIAdem or to use them as templates for 
your own applications. The table of contents of the ExampleFinder contains procedures which 
are step-by-step instructions for the solution of certain tasks.

Note If the introduction screen does not appear when DIAdem launches, select 
Help»Introduction to open the introduction screen.

Figure 1-2.  The DIAdem Introduction Screen
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2
Finding Data

Use DIAdem NAVIGATOR to find, to load, and to manage data. Use DataFinder to search for 
data on your computer and in the network, and to navigate through the found data files and 
databases. You load the data into the Data Portal so that all DIAdem panels can work with the 
data, which is organized in channels.

Mining Data
Use the Quick Search to search for a term if you do not know whether the property belongs to 
a file, a group, or a channel. Use the Advanced Search to combine multiple search conditions 
and describe exactly what properties you are looking for. 

Executing a Quick Search
To find data with a Quick Search, complete the following steps.

1. Select DIAdem NAVIGATOR. 

The file browser in the NAVIGATOR panel offers external data in a tree structure. 

2. In the search input area, type Weather to find all data sets that contain the term Weather. 

3. Click Search. 
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In the quick search DIAdem does not distinguish whether the data set contains the term as 
the name or the property of a file, of a channel group, or of a channel. DIAdem displays all 
files containing the term Weather or compound terms such as Weather data in the 
search results, as shown in Figure 2-1.

Figure 2-1.  Search Results of the Quick Search

Executing an Advanced Search
To narrow down the results of the Quick Search with an Advanced Search, complete the 
following steps.

1. Click the Advanced Search button to specify the search result more precisely, as shown in 
Figure 2-2.

2. In the Level column of the first row, click File and select Group.

a. Click <Enter a property> in the Property column of the first row and select Name.

b. Click the button with the three dots at the end of the first line. DIAdem lists the names 
of all the groups found.

c. Double-click the group name Weather. 
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Note If the list does not contain the term Weather, DIAdem has not yet indexed 
all sample files. Select Settings»MyDataFinder»Configure»Indexer»StartNow to 
start indexing.

Define another search condition in the second row to specify the search more accurately. 

3. In the Level column of the second row, click File and select Channel.

a. Click <Enter a property> in the Property column of the second row and select 
Name.

b. Click the button with the three dots at the end of the second row. DIAdem lists the 
names of all the found channels, as shown in Figure 2-2.

c. Double-click the channel name Precipitation. 

Figure 2-2.  Selection List with the Channel Names of the Indexed Data

As you can see in the logical operations line below the search conditions, DIAdem connects 
several search conditions with the AND operator by default. 

4. Replace AND with OR in the logical operations line for the following operation:

C1 OR C2
5. Click Search. 
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DIAdem displays the Search Results as shown in Figure 2-3. Each of the files found 
contains either a group called Weather or a channel called Precipitation.

Figure 2-3.  Search Results of the Advanced Search

Browsing in Data Sets
Complete the following steps to open data files in the file browser in order to inspect search 
results.

1. In the search results, right-click the Data1.tdm file.

2. Select Display in File Browser from the context menu.

DIAdem switches from the search results to the file browser and displays the file 
Data1.tdm in the tree view. 

3. Click the plus sign in front of the file icon.

4. Click the plus sign in front of the Weather channel group icon.

5. Click the Precipitation channel.

DIAdem lists all the channel groups and channels that are contained in a file, in a tree 
structure. You can browse the folders and files down to channel level if the data format allows 
you to browse. For more information about the selected file, channel group, or channel, refer 
to the Properties window below the File Browser, as shown in Figure 2-4. If you select a 
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channel, the channel preview to the right of the properties display shows the channel data as 
a curve.

Figure 2-4.  Browsing the Found Files in the File Browser

Loading and Managing Data
If you want to work with the data you found, you must load the data into the Data Portal. To load 
data and to remove unnecessary data, complete the following steps.

1. Click Delete Internal Data on the toolbar.

2. In the file browser, click the Weather channel group to select that channel group.



2-6 | ni.com

Chapter 2 Finding Data

3. Drag and drop the selected channel group into the Data Portal.

The Data Portal displays the new channel group Weather with all channels, as shown in 
Figure 2-5. If you select a channel, the channel preview of the Data Portal displays the 
channel data as a curve.

Figure 2-5.  Loading Data from the File Browser to the Data Portal

Note If you modify data in the Data Portal, DIAdem does not automatically save 
these changes. The changes are executed only in the memory and not in the data file 
from which you loaded the data. This enables you to experiment with data without 
modifying the original data.

Saving Data
In the Data Portal, click Save to overwrite the Data1.tdm file with the current data from the 
Data Portal. To save the data of the Data Portal in another location under a different name, carry 
out the following steps.

4. In the National Instruments folder, navigate to the DIAdem Data folder. 

5. Select the Weather channel group in the Data Portal.

6. Drag and drop the Weather channel group onto the Data folder.

7. Enter Weather data in the Save As file name dialog box.

8. Change the file type to National Instruments TDM Files (*.tdm).

9. Click Save.
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Summary
The summary provides an overview of the topics discussed in this chapter. It also includes 
additional information.

DataFinder
In the search input area of the DataFinder, you enter search conditions to find your data. You can 
also drag and drop properties from the properties display of the Data Portal or of the file browser 
into the search input area. In the logical operations line, you connect the search conditions with 
AND and OR and use parentheses to specify queries more precisely. DIAdem lists the files 
found in the search areas on the Search Results tab. 

SystemLink TDM
SystemLink TDM's DataFinder instances index data files on the network and allow multiple 
DIAdem users to access common search areas simultaneously. You can enable security settings 
and use archiving systems. 

Search Areas 
Search areas are folders of the file system, which the DataFinder indexes. Select 
Settings»MyDataFinder»Configure to modify the search areas of the DataFinder. 

File Browser
The File Browser displays the files of the search areas in a tree structure. Right-click the empty 
space of the file browser to open the context menu and hide or show the folders of the local file 
system in a separate tree. 

Internal Data in the Data Portal
DIAdem manages internal data in the Data Portal, which is visible in all panels. In all DIAdem 
panels you work with the channels of the internal data and their descriptive information. 
DIAdem saves result data in the Data Portal. You can display and edit the channel contents in 
DIAdem VIEW. 

Tip To highlight multiple channels in the Data Portal without using the <Shift> or 
<Ctrl> keys, click the icons next to the channel name. DIAdem displays a cursor with 
a plus sign.

Channel groups
Channel groups contain channels and descriptive properties of the channel groups. Use different 
channel groups to organize your data. You can define a channel group as a default group, for 
example, to automatically group together all the calculation results from DIAdem ANALYSIS. 
DIAdem displays the group name of the default group in bold type.

Channels
Channels contain data series which you either measured, loaded from an external data set, or 
calculated with DIAdem. DIAdem distinguishes numeric channels, xy-channels, waveform 
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channels, time channels, and text channels. Numeric channels contain numeric values, 
waveform channels contain numeric values and the associated x-channel, time channels contain 
time values, and text channels contain text.

Properties
Properties are information about the data, which DIAdem saves with the data series in a TDM 
file. The data set properties contain the name of the author and the storage date, the channel 
group properties contain the name of the measurement and comments, and the channel 
properties contain the data type and the channel unit. In addition to the standard properties, you 
can create your own custom properties for the data set, the channel group, and the channel. 
DIAdem displays the properties in the properties displays of the file browser and of the Data 
Portal.

Units Catalog
The channel unit is a special channel property because you can organize the channel units in the 
units catalog. Use the units catalog to assign a physical quantity and a unit to measurement 
values, for example, the quantity speed and the unit kilometers per hour. If you assign the unit 
mile per hour from the units catalog to the speed channel, DIAdem can convert the channel 
values.
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3
Viewing and Evaluating Data

Use DIAdem VIEW to view, to analyze, and to edit data as curves in axis systems. In channel 
tables you can edit and delete the data as values and enter new data. You synchronize videos or 
the map display of a test drive with data.

Viewing Curves 
To view the loaded data set in an axis system, complete the following steps.

Note If you did not complete the exercise in the previous chapter, delete the current 
data from the Data Portal and load the Data1.tdm data set from the DIAdem Data 
folder. You can find this folder in the DIAdem NAVIGATOR file browser in the 
National Instruments search area.

1. Select DIAdem VIEW.

2. Click New Layout.

3. Open the function group Regular Worksheet Partitions and select Two Areas.

Note Each panel has its own group bar on the left. When you click a button on the 
group bar, DIAdem opens the function group where you can select a function.

4. In the Data Portal, select the numeric channels T_max and T_min by clicking the symbol 
in front of the channel name. The cursor changes its color and displays a plus sign.

5. Drag and drop the two channels selected in the Data Portal into the upper worksheet area.

6. Select 2D Axis System in the selection dialog box. 
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DIAdem displays the axis system, as shown in Figure 3-1.

Figure 3-1.  Viewing Temperature Data as Curves

Note If you select multiple numeric channels in the Data Portal and drag them into 
an axis system, DIAdem assigns the first selected channel to the x-axis. If you select 
only one channel, DIAdem uses the index to display a numeric channel, and uses the 
x-channel to display an xy-channel and a waveform channel. 

Editing Curves
In DIAdem VIEW you can measure curves, and copy, delete, and interpolate curve sections. Use 
the curve cursor, the maximum values cursor, or the minimum values cursor on the DIAdem 
VIEW toolbar to measure a curve. To edit curve sections, use the flag functions on the axis 
system toolbar. The functions on the toolbar of the axis system influence the curves in the 
associated axis system, whereas the functions on the DIAdem VIEW toolbar influence all areas.

Measuring Curves
To follow the curve points with the curve cursor in an axis system, complete the following steps.

1. Click Curve Cursor on the tool bar.

2. Click the axis system and move the curve cursor along the curve. 

DIAdem displays the x-values and the y-values of the curve points in a tooltip next to the 
crosshair cursor that follows the cursor.
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3. Click the red circle in the legend at the right edge of the axis system to select the other curve 
as the leading curve.

Note You can use the second check box next to the curve symbol to hide and show 
the curve in the axis system. 

DIAdem displays the coordinates of the new leading curve in the tooltip.

Copying Curve Sections
To select a curve section and to copy the data of the curve section into the Data Portal, complete 
the following steps. 

1. Click Band Cursor on the toolbar.

2. At the point 12.12, click into the axis system and drag the band cursor to 3.13.

Click between the two lines to move the band cursor along the curves. Move the cursor lines 
individually to specify the width of the band cursor.

3. In the axis system toolbar, click Set Flags to flag all the curve points of the leading curve 
in the selected time period.

Note If you press <Shift> at the same time, DIAdem flags the points of all curves 
in this period.

4. Click Flags: Copy Data Points in the toolbar of the axis system to copy the data of the 
selected curve points to new channels.

In the Data Portal, DIAdem creates a time channel and a numeric channel with the values 
of the copied curve section. 

5. Drag and drop the new channels into the bottom workspace. 
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6. Select 2D Axis System. DIAdem displays the copied curve section, as shown in Figure 3-2. 

Figure 3-2.  Selecting Curve Sections and Copying them into the Data Portal

7. On the DIAdem VIEW toolbar, click Remove Flags from All Data to disable the selection.

Editing Data in Channel Tables
In channel tables you can edit and delete data and add new data. You can enter or generate new 
data manually.

To edit values in a channel table and to generate new values, complete the following steps.

1. Open the function group Assigned Worksheet Partitions and select Channel Table.

DIAdem creates a new worksheet with a channel table.

2. Select the Comments, CopyXDate and CopyYT_Max channels in the Data Portal to drag 
and drop these channels into the channel table. 

DIAdem displays the columns in the order in which you select the channels in the Data 
Portal.

3. Click into the cell in row 10 of the CopyYT_max column.

4. Enter the value 1 and press <Enter>.
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DIAdem also displays the new value in the curve in the bottom axis system on the previous 
worksheet. 

5. Right-click next to the channel table or into an empty column and select Create New 
Channel from the context menu.

a. Enter the channel name Generated_Channel.

b. Click OK to create the new channel in the channel table and display it in the Data 
Portal.

6. Right-click the first cell of the empty column Generated_Channel and select Generate 
from the context menu.

a. Enter 0.5 as the step width and 100 as the number of values. 

b. Click OK to create the channel values. 

DIAdem displays the channel table, as shown in Figure 3-3.

Figure 3-3.  Editing and Generating Data in Channel Tables

To use the layout with all worksheets as a template for similar data sets, click Save Layout As 
in the DIAdem VIEW toolbar.
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Summary
The summary provides an overview of the topics discussed in this chapter. It also includes 
additional information.

Layouts
A layout can contain several worksheets. DIAdem saves layouts separately from the channels. 
You can reuse the layout as a template for data sets with a similar structure. 

Areas
Partition worksheets into areas to insert axis systems, channel tables, videos, contours, maps, 
dialog boxes, text, and images. You can move the separating bars to resize any area in a 
worksheet. Use the Assigned Worksheet Partitions function group to add new worksheets with 
predefined areas to a layout. 

Axis Systems
DIAdem VIEW provides 2D axis systems, polar axis systems, Bode axis systems, orbit axis 
systems, and shaft centerline axis systems which all display data as curves. In 2D axis systems 
you can display data as spikes or stair curves and add constants. To insert data into an axis 
system, drag and drop channels from the Data Portal into an axis system. Use the band cursor 
and the frame cursor to zoom curve sections. You open the legend on the right side of an axis 
system.

Graphics Cursor
DIAdem VIEW offers various graphics cursors for evaluating curves in axis systems. The free 
cursor moves freely in the axis system and the curve cursor follows the curve from curve point 
to curve point. Other graphics cursors determine the maximum values and the minimum values 
of a curve. If an axis system contains several curves, the graphics cursor follows the leading 
curve that you specify with the radio buttons in the legend. DIAdem synchronizes all cursors of 
a worksheet with each other and with videos. 

Flags
Use the band cursor and the frame cursor to mark curve sections with flags, to delete, to copy, 
or to recalculate the marked curve points.

Channel Tables
In channel tables you view the individual values of all channel types, edit the values and add new 
values or channels. In the display properties of a channel table, you can specify whether a 
channel table only displays the channels that were dragged and dropped into the table or whether 
the channel table automatically displays all channels of a group or of the Data Portal.

Videos
In video areas you show videos. If you display the associated measured values as curves in an 
axis system, you can move a graphics cursor along the curves to display the video frame 
associated with each measurement value. Double-click an empty video area to insert a video.
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Contours
In contour areas you display 3D data two-dimensionally by displaying the third dimension of the 
data as a color value and with isolines. You can use a contour display, for example, to display 
and to analyze characteristic diagrams. If you move the graphics cursor over a contour, DIAdem 
displays the associated isolines dynamically. You can save the data of every associated isoline 
and also the x-parallel and y-parallel intersection in the Data Portal. 

Cascades
In cascade areas, for example, you can display oscillation data as a waterfall by mapping the 
oscillation amplitude over the frequency as a cascade in consecutive tracks. You can zoom into 
interesting areas and move over them with different measurement cursors. You can also show 
dynamic and static order lines, which help evaluate the rpm-related vibrations.

Maps
In map areas you display geographic data in map sections. For example, you can follow the route 
of a test drive when you move the graphics cursor in an axis system along the data, such as 
consumption, RPM, and torque, collected during the test drive. To do so, enter the recorded 
longitude and latitude and, for example, the time channel for synchronization.

Dialog Boxes
In dialog boxes you enter values, check settings, or start functions to change the displays in other 
areas of the layout during the analysis. You can include every user dialog box to which you 
added the VIEWConnector control in the dialog editor of DIAdem SCRIPT. 
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4
Analyzing Data with 
Mathematical Functions

Use DIAdem ANALYSIS to analyze data mathematically. You can apply predefined standard 
mathematical functions, including basic mathematics, curve fitting, signal analysis, and 
statistics. The dialog boxes for these standard functions guide you through the calculation, so 
you do not have to enter a formula. You select the input data and the settings. Use the DIAdem 
Calculator to define and calculate your own formulas.

Using Mathematical Standard Functions
DIAdem offers libraries with standard mathematical functions that you can use in DIAdem 
ANALYSIS in various function groups. The results of the calculations are displayed in new 
channels in the Data Portal.

Note If you did not complete the exercise in the previous chapter, delete the current 
data from the Data Portal and load the Data2.tdm data set from the DIAdem Data 
folder. You can find this folder in the file browser of DIAdem NAVIGATOR in the 
National Instruments search area.

To create a new group for the calculation results, complete the following steps.

1. Select DIAdem ANALYSIS.

2. Right-click in the Data Portal and select New»Group from the context menu.

3. Enter Results as the Name. Enable the checkbox Set default group.

4. Click OK.

DIAdem displays the name of the default group in blue font in the Data Portal.



4-2 | ni.com

Chapter 4 Analyzing Data with Mathematical Functions

Calculating the Sum of Channel Values
To total the precipitation for the year 2012, complete the following steps.

1. In the Statistics function group, select Descriptive Statistics.

2. Select the [1]/Precipitation sum channel in the Data Portal. 

This notation refers to the channel Precipitation sum in the first channel group.

3. Use Drag&Drop to insert this channel into the Channels input field in the Object to be 
evaluated section. 

4. Deactivate Calculate over all rows and enter the rows 2-13.

Tip To check in which rows the precipitation of the year 2012 is located, switch to 
DIAdem VIEW and load the channels Month and Precipitation sum into a 
channel table. The Month channel contains the time values for the monthly 
precipitation totals.

5. Enable Sums»Measured values on the Characteristic values 1 tab.

Note On the Characteristic Values 2 tab, click All off if characteristic values 
have already been selected.
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DIAdem displays the Descriptive Statistics dialog box, as shown in Figure 4-1. The dialog 
box displays the channel preview of the precipitation sum in the top right-hand corner and 
displays the result data below the channel preview.

Figure 4-1.  Precipitation Summation in Sections

6. Click OK to calculate the sum and to close the dialog box.

DIAdem stores the result in the custom properties of the channel Precipitation sum.

Note If you want to perform further calculations using this standard function, click 
Calculate. The dialog box remains open for further entries.

7. In the Data Portal, click [1]/Precipitation sum and open the property Custom 
properties»ResultStatSum.

8. Right-click Sum and choose Rename. Enter Result~Precipitation_2012 as the 
property name and press <Enter>.

Averaging Channels
To calculate the average monthly temperatures, complete the following steps.

1. In the Channel Functions function group, select Average Channels.



4-4 | ni.com

Chapter 4 Analyzing Data with Mathematical Functions

2. Select the channels [1]/Tm_min and [1]/Tm_max in the Data Portal.

3. Use Drag&Drop to insert this channel into the Channels input field in the Channels to be 
averaged section. 

DIAdem displays the dialog box, as shown in Figure 4-2.

Figure 4-2.  Averaging Minimum and Maximum Temperatures

4. Click OK.

5. Right-click Results/Mean in the Data Portal and select Rename. Enter Temperatures 
as the channel name and press <Enter>.

Calculating with the Units Catalog
The DIAdem units catalog organizes physical quantities and the associated units. Use the units 
catalog to convert channels into other units.

To convert the calculated average monthly temperatures from degrees Celsius to degrees 
Fahrenheit, complete the following steps.

1. In the Channel Functions function group, select Convert Channel Unit.

2. The Channel input field in the Channel to be calculated section contains the 
[2]/Temperatures channel.

If you see a different channel, select Results/Temperatures and drag and drop the 
selected channel into the input field.
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3. Select Unit»To [°F] degree Fahrenheit, as shown in Figure 4-3.

Figure 4-3.  Converting Channel Units with the Units Catalog

4. Click OK.

5. Right-click Results/UnitConverted in the Data Portal and select Rename. Enter the 
channel name Temperatures_F and press <Enter>.

Note You can also convert channel data to another unit in the Data Portal. To do so, 
click the unit entry field in the properties display and click the button with the three 
dots to open the Symbol Input Help dialog box.

DIAdem ANALYSIS displays a record of the calculations, as shown in Figure 4-4, and the Data 
Portal displays new channels with the calculation results. 

Note Click Export ANALYSIS Log on the toolbar to save the calculation log as 
HTML file.
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Figure 4-4.  Calculations with Standard Functions Log

Refer to Figure 5-3 in the next chapter to view the curves of the average temperatures and the 
annual precipitation.

Calculating Formulas with the Calculator
Use the DIAdem Calculator to calculate your own mathematical formulas. In the Calculator you 
calculate with channels, variables, and values you enter. DIAdem stores the results in channels 
or variables. 

To calculate the difference between maximum monthly temperatures and average temperatures, 
complete the following steps.

1. Click Calculator on the toolbar.

2. Enter the following formula in the Calculator entry field.

Ch("Results/TmMax_Diff")=Ch("[1]/Tm_max")-Ch("[2]/Temperatures")

Tip Instead of typing in the entire formula, copy this line and paste it into the 
Calculator. 
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Figure 4-5.  Calculating Formulas with the Calculator

3. Click the Calculate button and exit the dialog box through the red close window button. 

DIAdem adds the new channel TmMax_Diff to the Results channel group in the Data 
Portal. 

Summary
The summary provides an overview of the topics discussed in this chapter. It also includes 
additional information.

Mathematical Functions
DIAdem ANALYSIS offers a variety of standard functions for analyzing your data. You assign 
input channels to standard functions, set parameters, and execute the calculation. Click OK to 
execute a calculation once and to close the dialog box. Click Calculate to execute several 
calculations with the same standard function. 

Result Channels
DIAdem ANALYSIS saves calculation results in new channels. This enables you to calculate 
new data without overwriting the existing channels. In most dialog boxes of the standard 
functions, you can select Store result in original channel to overwrite the existing channels.

Custom Properties
Some standard functions, such as descriptive statistics or approximation store the calculated 
characteristic values as custom properties in the result or input channels.
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Default Group
DIAdem stores the result channels of a calculation in the default group in the Data Portal. In the 
context menu you can define a different group as the default group. DIAdem displays the group 
name of the default group in blue font.

Calculator
Use the Calculator to specify your own formulas for analyzing data. The Calculator has 
functions that range from simple arithmetic functions to advanced scientific and engineering 
functions. Use the Calculator to calculate channels, variables, and single values. DIAdem stores 
the results in channels or variables. 

Units
If you assign units from the units catalog to the original channels, DIAdem automatically 
determines the unit of the result channels. Based on the physical quantities and units of the 
original channels, the division of distance by time results in a speed with the unit kilometers per 
hour, for example. Settings»Units allows you to add your own units and define unit sets with 
preferred units.

Calculation Manager
To execute recurring analysis sequences with a mouse-click you can define simple as well as 
complex calculations in the calculation manager. An analysis sequence can contain user-specific 
formulas and default functions and can combine calculations when one calculation step accesses 
the result from a different calculation step.
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5
Creating Reports

Use DIAdem REPORT to document data and present results. In 2D and 3D axis systems, you 
display your data as curves, bar diagrams, and surfaces. In 2D and 3D tables, you list channel 
contents. You can label your report with comments and text and illustrate the report with 
graphics and formulas. You use the Chart Wizard to create and modify 2D axis systems and 
polar axis systems.

Creating Axis Systems
To create a new layout with the Chart Wizard, complete the following steps.

Note If you did not complete the exercise in the previous chapter, delete the current 
data from the Data Portal and load the Data3.tdm data set from the DIAdem Data 
folder. You can find this folder in the file browser of DIAdem NAVIGATOR in the 
National Instruments search area.

1. Select DIAdem REPORT.

2. Click New Layout.

3. In the Data Portal, select the channel Weather/Month and then the channels 
Weather/Precipitation sum and Results/Temperatures.

4. Right-click a selected channel and select Chart Wizard from the context menu. 

DIAdem opens the Chart Wizard and creates a new worksheet with an axis system. In the 
axis system, DIAdem displays the channels that are selected in the Data Portal as curves. 
DIAdem assigns the first selected channel Weather/Month to the x-axis. 

In Step 1 you select the diagram type. In Step 2 you add or delete curves. In Step 3 you 
specify the diagram display on several tabs. The preview, as shown in Figure 5-1, directly 
displays how the diagram changes.

5. Select the Lines diagram type, and then click the Lines with Multiple Y-Axes subtype. 
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Figure 5-1.  The Chart Wizard Displays the Preview in the Worksheet

6. Click Next twice to open Step 3 of 3.

7. Select the X-Axis tab. 

8. Enable Manual from for the value range and enter 01/01/2012 as the start and 
12/31/2012 as the end.

9. Click Finish to create the axis system.

In the axis system, DIAdem displays the monthly precipitation and the monthly average 
temperatures over the date.

Tip You can open the Chart Wizard from several locations in DIAdem REPORT. If 
you want to display curves with various x-channels, open the Chart Wizard on the 
toolbar. If you want to insert axis systems into the current worksheet, open the Chart 
Wizard from the 2D Axis Systems function group or the Polar Axis Systems 
function group. If you want to edit an axis system, open the Chart Wizard from the 
context menu of the axis system.

Editing Axis Systems
You can move and resize axis systems or parts of an axis system. To make it easier for you to 
see which objects you can select, DIAdem displays an object in a blue frame as soon as the 
mouse cursor idles on the object. Double-click the object to open its settings. 

Complete the following steps to display the precipitations as bars.
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1. Double-click the red curve of the precipitation sum to open the associated curve parameter.

2. Select the Bars Display type and the 2D Bars Display mode.

3. Select the Filling color Blue and a Right diagonal Filling.

4. Click OK.

DIAdem displays the worksheet, as shown in Figure 5-2.

Figure 5-2.  DIAdem Displays the Precipitation as Bars

5. Click once into a free space in the axis system to select the axis system. 

6. To reduce the width of the axis system, move the small square in the middle of the right 
edge of the selected axis system to the left. 

Graphics and Lines
Illustrate reports with graphics and company logos. Use lines and rectangles to partition the 
worksheet through lines or to highlight a textbox. 

To add a graphic to your worksheet, complete the following steps.

1. In the Graphics function group, select Load Graphic.
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2. Select Weather.jpg in the DIAdem Documents folder and click Open.

3. Click and drag the graphic to the right edge of the workspace. 

4. Resize the graphic by dragging the small squares at the corners of the graphic.

To prepare a description field on the right of the worksheet, complete the following steps.

1. Open the function group Lines and Arrows and select Continuous Vertical Line.

DIAdem inserts a vertical line on the right edge. 

2. Move this line slightly to the left to widen the description field.

Using Text and Variables as Labels
Add text and variables to a report to explain the contents and highlight specific items. All texts 
can include formula expressions and DIAdem variables, which DIAdem updates along with the 
rest of the report. Double @ characters indicate to DIAdem which parts of the text to evaluate 
dynamically. 

To add a text to your report, complete the following steps.

1. Click Text on the group bar and select Text. The cursor changes to a text cursor.

2. In the worksheet, click into the textbox at the top and type Weather Report.

3. Press <Enter> and enter @@CurrDate@@ in the second row. 

4. Click outside the text to conclude the entry. 

5. Click the text. To resize the text, drag the small squares at the corners of the text with the 
mouse.

Adding and Formatting Channel Properties
In the dialog of the text editor, you edit the text and use variables and expressions that are 
available to you when you click the button with the three dots at the end of the input field. You 
can easily drag and drop channel properties from the Data Portal into the worksheet.

To add a channel property to your report and to edit the channel property, complete the following 
steps.

1. In the Data Portal, click [1]/Precipitation sum and open the property 
Result»Precipitation_2012.
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2. Drag this custom property into the textbox.

3. Double-click the inserted text. The text editor displays the following text:

Result~Precipitation_2012: @@Str(Data.GetChannel("[1]/ 
Precipitation sum").Properties("Result~Precipitation_2012"). 
Value,"AutoAdj")@@
a. Replace the first term Result~Precipitation_2012 with the description 

Annual precipitation.

b. Press <Enter> to position the value below the text.

c. Enter mm at the end of the text.

4. Click the Position tab and select Centered as the Relative position.

5. Click OK. 

6. Select both texts and the graphic.

7. Click Orientation on the group bar and select Vertical.

DIAdem displays the worksheet, as shown in Figure 5-3.

Figure 5-3.  Using Text and Variables as Labels

To use the layout as a template for similar data sets, click Save Layout As.
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Summary
The summary provides an overview of the topics discussed in this chapter. It also includes 
additional information.

Layouts
A layout can contain several worksheets. DIAdem saves layouts separately from the channels. 
You can reuse layouts as templates for data sets with a similar structure. 

Worksheets
Worksheets contain axis systems, tables, text, formulas, and graphics. To add data to the 
worksheet, drag and drop channels from the Data Portal into axis systems and tables. In addition 
to selecting data channels from the Data Portal, you also can add data channels by 
double-clicking an axis system or a table. 

Select Settings»Layout Setup»Worksheet Parameters to change the page format of a 
worksheet so that, for example, the table of contents is in portrait format, whereas the diagrams 
remain in the landscape format.

Export your report as PDF, XPS, and HTML files or individual pages as graphics in various 
formats, such as PNG, JPG, GIF, TIF, and EMF. Under Settings»Layout Setup»Layout 
Parameters you can add custom properties to a report, for example, the name of a test sequence, 
in order to search for this property with DataFinder.

Master Layout
Use a master layout to create a uniform appearance for reports. The master layout remains 
unchanged in the background of all worksheets and consists of a landscape master and a portrait 
master. To create a master layout, select File»Master Layout»New. 

Chart Wizard
You can use the Chart Wizard to create and to modify 2D axis systems and polar axis systems. 
The preview function displays each changed setting in the worksheet.

Axis Systems
Use axis systems to display channels as curves, as bars, and as surfaces. You double-click an 
axis system to edit the displayed curves, to add new curves, and to delete existing curves. To 
zoom curve sections, change the scaling of the x-axis and the y-axis with the mouse wheel as 
soon as you position the cursor over the respective axis.

Tables
Use tables to list the contents of numeric channels and also text channels. Double-click into table 
to edit the displayed columns, to add new columns, and to delete existing columns. 
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Text
Use text to label worksheets. Use Add Curve Coordinates in the context menu of a curve to 
add comments to values. Text also can include variable information, such as filenames or the 
current date. For DIAdem, the @@ characters indicate a variable expression. Click Refresh on 
the DIAdem REPORT toolbar to display the current variable contents. 

Formulas
Use formulas to display calculation instructions in graphics. DIAdem uses the formula syntax of 
the Mathematical Markup Language (MathML) used in word processing.

Graphics
Use graphics and logos to illustrate worksheets. DIAdem supports numerous different graphic 
formats including PNG, BMP, JPG, TIF, and WMF.



© National Instruments Ireland Resources Limited | 6-1

6
Automating Sequences

Use DIAdem SCRIPT to automate tasks in a script, which combines several work steps for 
recurring sequences, such as standard calculations and serial evaluations. Scripts, which you can 
record interactively, use the functions of all DIAdem panels. You can add program structures 
and dialog boxes to scripts in the integrated script editor. 

Creating Scripts
The recording mode is the easiest way to create scripts. If you enable the recording mode, 
DIAdem creates a new script in the Script Editor and logs your actions in this script. To create 
a new script in the recording mode, complete the following steps.

1. Select DIAdem SCRIPT.

2. On the toolbar, click Enable Recording Mode to start recording a script.

a. In the dialog box that opens, enter DIAdem User as the Author and Manual 
Example as the Comment.

DIAdem writes this information directly into the script code to help you identify the 
script in the future.

b. Click OK. 

3. Select DIAdem NAVIGATOR.

4. Click Delete Internal Data to delete the data in the Data Portal.

DIAdem asks if you want to save the data you modified in the Data Portal.

5. In the search input area of the quick search, type Weather and click Search.

6. Drag and drop the Data1.tdm file into the Data Portal.
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7. Select DIAdem ANALYSIS.

8. In the Channel Functions function group, select Average Channels.

a. Select the channels [1]/Tm_min and [1]/Tm_max in the Data Portal.

b. Use Drag&Drop to insert this channel into the Channels input field in the Channels 
to be averaged section. 

c. Click OK to calculate the mean values and to close the dialog box.

9. Select DIAdem REPORT.

10. Click Load Layout.

a. Select Report2.tdr and click Load.

DIAdem updates the screen display and displays the loaded data set.

11. Select DIAdem SCRIPT.

12. Click Disable Recording Mode.
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DIAdem displays the recorded script in the script editor, as shown in Figure 6-1.

Figure 6-1.  Recording Actions in the Script Editor

After the commenting header, DIAdem declares the MyFolders path variable and assigns to 
this variable the paths to the data folder and to the document folder. If you want the script to load 
the data file or the layout file from another folder, just change the paths at this point in the script. 

Editing Scripts
In the recording mode you have recorded the search for weather data, loaded a data set, and 
created a report. Expand the recorded script to evaluate further weather data. 

To select data interactively complete the following steps.

1. Replace the script line for loading the data file Data1.tdm
Call DataFileLoad(MyFolders(0)&"Data1.tdm","TDM", 
"LoadOnWriteAccess|ChnXYRelation")

with the following script lines:

Call WndShow("NAVIGATOR","OPEN")
Call InteractionOn("Load Data4.tdm")

The first script line opens the NAVIGATOR panel and the second line stops the script so 
that you can load data interactively.
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2. After the last script line, enter the statement to hide the Data Portal and use 
CodeCompletion.

a. Enter Portal..

As soon as you enter the dot behind the Portal object, DIAdem offers the methods 
and properties available for this object for selection, as shown in Figure 6-2. 

Figure 6-2.  CodeCompletion and SmartInfo Make Editing Objects Easier

b. Double-click Visible to insert this property into the script.

c. Complete the script line as follows:

Portal.Visible = False 

DIAdem displays the respective SmartInfo for every element in the selection list. Click Display 
Help on this Subject to open the help page on this object. 
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Testing Scripts
To test the modified script, complete the following steps.

1. Click Run Script.

The script opens the NAVIGATOR panel and displays in the Search Results all the data 
files that contain the search term Weather.

2. Select Data4.tdm to drag&drop the file into the Data Portal.

3. Click the Load Data4.tdm message box to end the interaction.

The script opens the REPORT panel. DIAdem updates the date displayed in the heading and 
hides the Data Portal, as shown in Figure 6-3.

Figure 6-3.  Report Created with the Script

4. Click Data Portal to re-enable the Data Portal for further actions.

To save the script, select DIAdem SCRIPT and click Save File As.
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Summary
The summary provides an overview of the topics discussed in this chapter. It also includes 
additional information.

Scripts
Scripts allow you to execute a series of commands for finding data, loading data, analyzing data, 
and creating reports. Scripts provide the VBS functionality and DIAdem functions. You can 
integrate the standard dialog boxes in scripts or you can create your own dialog boxes.

Recording Scripts
In the recording mode DIAdem records the command for every action that you execute 
interactively, in a script.

<Ctrl-Shift-C>
In the recording mode, DIAdem does not usually record the value assignment for object 
properties and variables. Press <Ctrl-Shift-C>, for example, in a DIAdem REPORT dialog box, 
to record the values of properties and variables. If DIAdem is not in the recording mode, also 
copy the assignment of values with <Ctrl-Shift-C>, but this time to the Windows clipboard. 
Then insert these assignments into a script and modify the required properties and variables.

Script Editor
The script editor displays the program code of scripts. While you record actions in the recording 
mode, DIAdem records the commands directly in the script editor. Use functions such as go to 
line, bookmarks, restoring, and find and replace, to make script editing easier.

If you click a command, a property, a method, or a variable, the SmartInfo displays the 
parameters of the command, the property, the method, or the value range of the variable. For 
further information click Display Help on this Topic. 

CodeCompletion
If you enter the name of an object and complete the entry with a dot, the script editor offers the 
subobjects, events, properties, and methods that are available for this object. Add your selection 
to the object in the script with a double-click.

When you enter the first characters of a command, for example, and press <Ctrl-Spacebar>, the 
script editor automatically completes the command. If several commands start with these 
characters, the script editor offers a selection list of all the possible objects, commands, and 
procedures.

Interaction Mode
When you use the interaction mode, you can stop your script and work interactively with 
DIAdem. Use the InterActionOn command to enable the interaction mode in scripts. You 
end the interaction mode with the End interaction button in the toolbar of each panel or in a 
message box.



© National Instruments Ireland Resources Limited | 6-7

Getting Started with DIAdem

User Commands
To add commands to DIAdem, you can define user commands in a script. For example, you use 
user commands to run calculations in the calculator, to format axis systems in DIAdem 
REPORT, or to extend the range of functions in scripts. 

User Dialog Boxes
Create user dialog boxes with the dialog editor of DIAdem SCRIPT in order to 
enter values, search for settings, or start functions. Use events to connect elements from user 
dialog boxes and specify how the script proceeds depending on the previously specified settings.
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7
Data Acquisition and 
Visualization

With DIAdem DAC and DIAdem VISUAL you acquire data, control processes, and visualize 
data. In DIAdem DAC you create block diagrams to acquire measurement values and to process 
and output the measurement values during the measurement. In DIAdem VISUAL you design 
the visualization to display the acquired and calculated measurement values and to influence the 
measurement with input instruments.

Acquiring Measurement Data
In DIAdem DAC you select functions blocks from the various function groups and connect them 
with signal buses, to create block diagrams. The measurement data is transferred from data 
sources to processing blocks, display instruments, and output blocks. 

To create a block diagram with a simulated signal source, complete the following steps:

Note You can later replace the simulated signal with measured data.

1. Select DIAdem DAC.

2. Click New Block Diagram.

3. In the Simulation Inputs function group, select Function Generator.

4. In the Display Instruments function group, select Numeric Display.

DIAdem inserts every new block in the top left corner of the workspace in DIAdem DAC. 



7-2 | ni.com

Chapter 7 Data Acquisition and Visualization

5. Move the block Digits1 to the right of Generator1.

6. Click the output on the right side of Generator1. Drag the green line to the input on the left 
side of the Digits 1 block. As soon as OK appears on the cursor, you can release the mouse 
button. 

The data source and the display instrument are now linked with a green data bus similar to 
Figure 7-1. 

Figure 7-1.  Block Diagram with Function Generator and Digits Display

7. Click Start Display on the toolbar. 

DIAdem opens the DIAdem VISUAL panel and displays the simulated sine values in a 
Digits display.

8. Click Stop Measurement.
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Saving Measurement Data
Until now you have displayed the signal values, but the values are not yet saved. To document 
processes and to check results, DIAdem must save measurement values. 

To save the measurement data, complete the following steps.

1. Select DIAdem DAC.

2. In the System function group, select Save Data with Trigger. 

3. Place the Save1 block below the numeric display.

4. Click the green data bus and drag the bus to the data input of the Save block as shown in 
Figure 7-2.

5. Double-click the Save1 block.

a. Choose Parameters.

b. Enter 1000 values for Cycle»Save.

c. Click OK.

6. Click Start Measurement. 

DIAdem stops the measurement as soon as 1,000 values are saved.

7. Switch to DIAdem DAC. 

The new channels Time1 and Generator1_1 are now visible in the default group of the 
Data Portal.
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Figure 7-2.  Extended Block Diagram with Data Storage

Monitoring Measurement Signals
In control blocks you define conditions for monitoring and controlling measurements. 

To save measurement values in relation to a condition, complete the following steps. 

1. In the Simulation Inputs function group, select Slider Control. 

2. Place the Slider1 block below the function generator.

3. In the Control function group, select Window. 

4. Place the Window1 block next to the slider.

5. Drag a green bus from the output on the Slider control to the input on the Window 
condition.

6. Double-click the Window1 block. 
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a. Enter the lower limit -5 and the upper limit 5 in the signal list, as shown in Figure 7-3.

b. Select Window exit as the Window Type.

Figure 7-3.  Setting the Window Condition

c. Click OK.

7. Click the data bus between the Slider1 and Window1 blocks and drag a new bus onto the 
green bus between the Generator1 and Digits1 blocks.

The 2 at the input of the numeric display indicates that two signals now reach the block on 
this data bus.

8. As shown in Figure 7-4, drag a line from the output at the bottom of Window1 to the input 
with the red triangle at the top of the Save1 block. 

This creates a red control bus that DIAdem uses to trigger data storage. Always connect 
control buses at the top or at the bottom of a block.
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Figure 7-4.  Extended Block Diagram with Slider Control and Window Condition

Visualizing Measurements
You can arrange the input instruments and display instruments, which are integrated in the block 
diagram, in DIAdem VISUAL and you can con each instrument individually. 

To design the visualization complete the following steps.

1. Switch to DIAdem VISUAL.

The instruments Slider Control and Digit Display are positioned on top of each other at the 
top left of the display area of DIAdem VISUAL.

2. Position the two instruments next to each other.
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3. Select both instruments. 

a. Click Orientation on the group bar and select Vertical.

b. Click in the workspace to deselect it.

4. Click Start Measurement. 

5. Drag the slider control up and down. 

As soon as you leave the specified window range between -5 and +5 with the slider, 
DIAdem starts to save the measured values. Figure 7-5 shows the visualization.

Figure 7-5.  Visualization with Input Instruments and Display Instruments

6. Click Stop Measurement or wait until DIAdem has recorded the specified 1,000 values 
and created new channels in the Data Portal.

To save the block diagram, click Save Block Diagram As.
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Summary
The summary provides an overview of the topics discussed in this chapter. It also includes 
additional information.

DIAdem DAC
You use DIAdem DAC to describe measurement and control tasks in a block diagram. Select 
function blocks from the various function groups and connect the function blocks with the 
mouse. When you start a measurement, DIAdem opens the VISUAL panels and runs the 
visualization. 

Data Acquisition
The blocks on the Inputs function group represent data sources in DIAdem DAC, such as A/D 
converter boards, front-end devices, and other external measuring devices. You register the 
corresponding drivers in DIAdem DAC and con the signal inputs and signal outputs. Additional 
data sources can be input instruments, data files, and calculation results.

Signal Buses
Signal buses connect the function blocks and transport signals. Connect signal buses to the signal 
inputs and to the signal outputs on a function block. You can connect these buses with other 
blocks an also with other buses. To delete a bus, select the bus and press <Del>. DIAdem 
distinguishes between system buses, control buses, data buses, alarm buses, and text buses. 

DIAdem VISUAL
Select instruments such as gauges, digits, bar display, recorders, or wipers to display the 
measurement values from the DIAdem VISUAL library. You use input instruments such as 
switches, dials, or slider controls, to trigger events and control functions during a measurement. 
When you design a visualization, you can align and con instruments as you like.
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NI provides global services and support as part of our commitment to your success. Take 
advantage of product services in addition to training and certification programs that meet your 
needs during each phase of the application life cycle; from planning and development through 
deployment and ongoing maintenance.

To get started, register your product at ni.com/myproducts.

As a registered NI product user, you are entitled to the following benefits:

• Access to applicable product services.

• Easier product management with an online account.

• Receive critical part notifications, software updates, and service expirations.

Log in to your MyNI user profile to get personalized access to your services.

Services and Resources

• Maintenance and Hardware Services—NI helps you identify your systems’ accuracy and 
reliability requirements and provides warranty, sparing, and calibration services to help you 
maintain accuracy and minimize downtime over the life of your system. Visit ni.com/
services for more information.

– Warranty and Repair—All NI hardware features a one-year standard warranty that 
is extendable up to five years. NI offers repair services performed in a timely manner 
by highly trained factory technicians using only original parts at an NI service center.

– Calibration—Through regular calibration, you can quantify and improve the 
measurement performance of an instrument. NI provides state-of-the-art calibration 
services. If your product supports calibration, you can obtain the calibration certificate 
for your product at ni.com/calibration.

• System Integration—If you have time constraints, limited in-house technical resources, or 
other project challenges, National Instruments Alliance Partner members can help. To learn 
more, call your local NI office or visit ni.com/alliance.

http://www.ni.com/myproducts
http://www.ni.com/services
http://www.ni.com/services
http://www.ni.com/calibration
http://www.ni.com/alliance
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• Training and Certification—The NI training and certification program is the most 
effective way to increase application development proficiency and productivity. Visit 
ni.com/training for more information.

– The Skills Guide assists you in identifying the proficiency requirements of your 
current application and gives you options for obtaining those skills consistent with 
your time and budget constraints and personal learning preferences. Visit ni.com/
skills-guide to see these custom paths.

– NI offers courses in several languages and formats including instructor-led classes at 
facilities worldwide, courses on-site at your facility, and online courses to serve your 
individual needs.

• Technical Support—Support at ni.com/support includes the following resources:

– Self-Help Technical Resources—Visit ni.com/support for software drivers and 
updates, a searchable KnowledgeBase, product manuals, step-by-step troubleshooting 
wizards, thousands of example programs, tutorials, application notes, instrument 
drivers, and so on. Registered users also receive access to the NI Discussion Forums 
at ni.com/forums. NI Applications Engineers make sure every question submitted 
online receives an answer.

– Software Support Service Membership—The Standard Service Program (SSP) is a 
renewable one-year subscription included with almost every NI software product, 
including NI Developer Suite. This program entitles members to direct access to 
NI Applications Engineers through phone and email for one-to-one technical support, 
as well as exclusive access to online training modules at ni.com/
self-paced-training. NI also offers flexible extended contract options that 
guarantee your SSP benefits are available without interruption for as long as you need 
them. Visit ni.com/ssp for more information.

• Declaration of Conformity (DoC)—A DoC is our claim of compliance with the Council 
of the European Communities using the manufacturer’s declaration of conformity. This 
system affords the user protection for electromagnetic compatibility (EMC) and product 
safety. You can obtain the DoC for your product by visiting ni.com/certification.

For information about other technical support options in your area, visit ni.com/services, 
or contact your local office at ni.com/contact.

You also can visit the Worldwide Offices section of ni.com/niglobal to access the branch 
office websites, which provide up-to-date contact information, support phone numbers, email 
addresses, and current events.

http://www.ni.com/training
http://www.ni.com/skills-guide
http://www.ni.com/skills-guide
http://www.ni.com/support
http://www.ni.com/support
http://www.ni.com/forums
http://www.ni.com/self-paced-training
http://www.ni.com/self-paced-training
http://www.ni.com/ssp
http://www.ni.com/certification
http://www.ni.com/services
http://www.ni.com/contact
http://www.ni.com/niglobal
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